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Thank you for requesting the HyperStudio® Demonstration Kit! We have tried to put together
materials that will help you show HyperStudio and the power of hypermedia to others.

What We'll Do For You:

We're committed to doing everything possible to help you show HyperStudio to others, and
communicate to them the wide variety of uses now possible with this software and the Apple
aGs.

If you need any further materials in the way of promotional flyers, catalogs, more demonstration
kits, etc., let us know and we'll send them to you as soon as possible.

If you have any questions while using HyperStudio, feel free to call our technical support staff,
and we'll do everything in our power to make your experience with HyperStudio as enjoyable
and effortless as possible. '

If you would like to discuss potential new uses for HyperStudio, improvements to the software,
or the development of additional stacks, Xcmds or other utilities, we'll be there to do our best to
add everything we can to the entire HyperStudio environment.

What You Can Do For Us:

HyperStudio is a program that will change the way people think of the Apple IIGS, and give
that machine entirely new applications in many different areas. However, we need your help in
spreading the word about this product.

When you're presenting HyperStudio to others, please remind them that Demonstration Kits are
available from us to anyone doing presentations, workshops, or otherwise educating others
about computers. You can make copies of your Demonstration Kit for others after returning the
orange permission form, or have them contact us directly. HyperStudio Demonstration disks
(although not the printed materials) like those in this Demonstration Kit are also available at at no
charge from all participating authorized Apple dealers. Do try to get the HyperStudio message
out to others who, like you, are in a position to demonstrate HyperStudio to others, and
encourage them to let us help them the same way we've helped you.

Thanks! Together, we can bring a whole new vision to personal computing, and the Apple II!

L 2L
R’oé:x? Wagﬁ

President

» Nae 't
/09«/‘”‘“2%’/6?&’ 1EL
PUBLISHING, ¢ INC.

1050 Pioneer Way e Suite P e El Cajon, CA 92020 ¢ 619/442-0522






HyperStudio® Demonstration Series Distribution License

This Agreement, when signed by both parties, is formal written permission from Roger Wagner Publishing, Inc.
("RWP") for the undersigned (the "Licensee") to make copies of the HyperStudio Demonstration Series (the "Series")
for others. These copies are not to be sold, but a nominal sum may be collected by the Licensee to cover the cost of
disk duplication, if necessary.

The Licensee acknowledges that HyperStudio and portions of the Series which are derived from the commerical version
of HyperStudio are the property of RWP, and no rights are granted to the Licensee other than those specifically granted
herein.

The Licensee agrees to inform those receiving the Series that the Series is not Public Domain software, and that further
distribution by those parties is not allowed without written permission from RWP, Inc. RWP does encourage others to
contact RWP and request permission to distribute the Series in the interest of promoting HyperStudio and making
others aware of the product.

The Licensee agrees to not alter, or distribute software or information designed to alter, the HyperStudio program on the
Series disks, and to not remove or obscure, or distribute software or information designed to remove or obscure, any
copyright notices or other proprietary notices of Roger Wagner Publishing, Inc., Apple Computer, Inc., or any other
party from any of the stacks or programs in the Series.

RWP reserves the right to discontinue this promotion at any time, and to refuse licensing to any party at its discretion.
Upon termination by written notice by RWP, Licensee agrees to return or destroy all copies of the Series in its
possession, and to cease further distribution to others.

LIMITATIONS OF WARRANTY AND LIABILITY

ROGER WAGNER PUBLISHING, INC AND THE PROGRAM AUTHORS MAKE NO WARRANTIES EITHER
EXPRESS OR IMPLIED, REGARDING THIS COMPUTER SOFTWARE, ITS MERCHANTABILITY OR ITS
FITNESS FOR ANY PARTICULAR PURPOSE. ROGER WAGNER PUBLISHING, INC AND THE PROGRAM
AUTHORS SHALL HAVE NO LIABILITY OR RESPONSIBILITY TO ANY PERSON OR ENTITY WITH
RESPECT TO LIABILITY, LOSS OR DAMAGE CAUSED OR ALLEGED TO BE CAUSED DIRECTLY OR
INDIRECTLY BY THIS SOFTWARE, INCLUDING, BUT NOT LIMITED TO ANY INTERRUPTION OF
SERVICE, LOSS OF BUSINESS OR ANTICIPATORY PROFITS OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE USE OF THIS SOFTWARE. SOME STATES DO NOT ALLOW THE EXCLUSION
OR LIMITATION OF IMPLIED WARRANTIES OR LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THIS
COMPUTER SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC
LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE
TO STATE.

AGREED TO:
For Licensee (signature): For Roger Wagner Publishing, Inc.:
Licensee (print name): Date:

Company, Club, etc. if for that agency:

Address:

City, State, Zip:

Phone Number & Date:







An Introduction to HyperStudio®...

Welcome to the world of HyperStudio® and the world of hypermedia! HyperStudio provides you
with the complete system to create things on your computer that will make it more productive, more
educational, and just plain more fun than you can probably imagine.

But first, what is "hypermedia"? You're already familiar with the various ways of exchanging
information that currently exist. Newspapers, books, movies - all these are referred to as the media,
and are those channels that handle the mass distribudon of information. In addition, the term media
also refers to the specific physical form that carries the information. This can be the printed word, a
colorful artistic graphic, or an electronic image. However, for the most part, all of the current ways
of conveying information in the modern world are passive. That is, you act as a silent viewer of the
information presented.

The word "hyper" is derived from a Greek word meaning exmeme or beyond. The word hypermedia
was coined to describe a way of communicating that went beyond the current notions of the media.

Imagine starting with something commonplace, like a book. This is a typical form that information in
our world takes. Now imagine that on each page of the book was not only text and pictures, but
certain areas that you could touch with your finger that would suddenly expand into a whole new
page of information, or that would perhaps instantly take you to an entirely different part of the book,
perhaps even to a completely different book. While you're thinking of that, wouldn't it be nice if the
pictures on the page could actually be animated to show a bird flying, or the path that an army during
the Civil War followed? Better still, imagine hearing the sounds of the battle while you read the text!

Well, imagine no more, because this is exactly what hypermedia offers, and in partcular, what
HyperStudio delivers!

In this "hands-on" introduction, you'll see how a hypermedia application is created with
HyperStudio, and get an idea of the remendous variety of new applications now possible on the
Apple OGS!



The HyperStudio Package
The standard HyperStudio package consists of both hardware and software:
« Software: 4 disks; System disk, Program disk, Clip-Art disk, Sounds disk.

» Hardware: No-slot sound digitizer ¢ard and microphone.

Software

HyperStudio and its associated programs run under GSOS. The main programs included are:
« HyperStudio, the hypermedia viewing and authoring system for the Apple IIGS.

» Sound Shop, a dedicated sound digitizing and editing udlity.

+ Sound Browser, a utilirv for quickly scanning disks and listening to digitized sound files.

- Sight 'n Sound, a utlity for easily adding a start-up Super Hi-Res picture and/or sound that will
be used as a given GSOS disk is being started up. The system beep sound can also be replaced with
a custom recorded sound, such as breaking glass, an airplane crash, "oops!"”, or whatever.

Hardware

The hardware includes a sound digitizer and a microphone with stand. An .::onal battery-powered
amplified speaker is available separately for $9.95. The digitizing card does not require a peripheral

slot in the computer, and can be used in a "piggy-back" configuradon that allows the concurrent use
of other sound [/O hardware (Somc Blaster, MDIdeas, FutureSound etc.) without changing wiring,
removing cards, etc.

System Requirements

HyperStudio requires an Apple [IGS with a minimum le total RAM. It runs under GSOS, and can
be run on an AppleShare Network.

The memory requirements for any partcular stack depend entirely on the individual characteristics of
the stack you create. That is, depending on how many different backgrounds, graphics objects, and
imbedded sounds you use for a stack, the memory used by the stack can vary over quite a range.
With no imbedded sounds, and simple card backgrounds, your stack could have hundreds of cards in
it. HyperStudio is designed to optimize memory usage by compressing memory, and other
techniques. HyperStudio itself currently uses 256K of memory for the program itself and working
buffers. Typical stacks that we've seen so far average 200K.

Digitized sound requires approximately 10K of RAM per second of sound. Thus, a 10-second sound
would require 100K of memory. However, HyperStudio does not require that every sound in a
given stack be loaded all at the same time, and in pracuoe, the amount of sound available in a stack is
more a function of disk size.

Use of Stacks by Others

There is no license fee required for the distributon of stacks created with HyperStudio to others.
HyperStudio is required to run the stacks, but site-license and district-license arrangements are
available at a reasonable cost.



Miscellaneous HyperStudio® Points

The following text was prepared as a quick collection of thoughts on what makes HyperStudio
unique, and why it is a significant new level of software for not only the Apple IIGS, but
computers of all kinds. We hope it answers some of the questions you may have, and perhaps also
gives you some new ideas to think about.

1. Truly easy-to-use hypermedia specifically for the Apple IIGS. Not a clone of

HyperCard on the Mac, but software created from the start with the GS in mind. Many users have
said it's easier to use than HyperCard, in that HyperStudio is "auto-scripting". It lets you do
things, such as adding buttons, sounds, animation, etc. with just a mouse-click or menu choice,
that would otherwise require manual scripting in HyperCard, or other authoring systems.

HyperStudio does many things that would be considered "extras" in HyperCard or other systems,
such as support for laserdiscs, digitized sounds, touch-screens, animation, and much more.
HyperStudio is intuitive, offers immediate results, and is specifically created for the Apple TGS,
and also designed to perform and feel the way an Apple IIGS user would expect.

HyperStudio is used in grade levels as low as 1st grade. A 4th grade class in New York created an
entire "Class Autobiography" usmg HyperStudio, and even creating a interactive video laserdisc.
HyperStudio's "auto-scripting” means that anyone can create impressive stacks without having to
learn programming. Even if you are comfortable with programming, HyperStudio lets you achieve
the results you want in a fraction of the time otherwise required.

2. HyperStudio does not require a hard disk, or memory beyond the now-standard 1Mb
RAM. Once loaded, HyperStudio does not have to go back to the disk, unlike some disk-intensive
software packages. A single 3.5" disk drive is quite sufficient for using the software. In
addition, future run-time packages are planned for HyperStudio that will let users run (but not
create) stacks in as little as 768K RAM. HyperStudio is hard-disk and Appleshare network
compatible.

HyperStudio is sufficiently fast in its operation on a standard Apple IIGS. It is compatible with the
Transwarp GS, but functions very well without it.

3. HyperStudio is a very self-contained enwronment, while still maintaining compatibility with
third party software and hardware products It isn't necessary to buy a lot of add-ons to be able to
use the product.

At the same time, HyperStudio has built-in support for many advanced technologies, such as the
Edmark TouchWindow™, Apple® II Video Overlay Card, and the Pioneer 2200, 4200 and 8000
LaserDisc players.

4. HyperStudio now lets those who can benefit from a rich computer environment do so at a very
affordable cost. HyperStudio offers similar functionality to systems on the IBM or Macintosh that
would cost many times as much as an Apple IIGS and HyperStudio.

5. Outstanding features:

a. 640 mode color graphics. Built-in paint program. Can import graphics from 8/16 Paint,
PaintWorks Gold, Graphics Studio, Deluxe Paint II, and Computer-Eyes. [With Graphics
Exchange from RWP, users can also convert Print Shop, News Room, 320-mode graphics,
and even Macintosh clip-art].

Get clip-art function is rather nice in that it has uses a second window for the imported
graphic. Some paint programs require that you close what you've got, load 1st screen, copy
image, and then load orig. graphic for the paste. Package includes over 250 clip-art images.



Button actions include branching to other cards, stacks, launching applications, playing
sounds, animation, visual transition effects, right/wrong answer functions for tests,
user-defined "Xcmds" in Pascal, C, or assembly language, and more, all selected with
simple choices from menus and dialog boxes.

Built-in text editor. Can import text from most word processors (as ASCII text file or
AppleWorks 2.0+ word processor file).

Built-in sound digitizing. Includes sound digitizer card and microphone. Sounds can either
be recorded right when a stack is being created, or Sound Shop can be used for more
advanced editing functions. Many samples of music and sound effects are included in the
package.

Our digitizer is unique because it does not require a slot. Besides the obvious advantage of
not using valuable "real estate” in a machine that is ever more slot-hungry, our card is also
much more quiet in recording since we don't get any of the bus noise from the computer.
The "piggy-back" design of the connectors on the card also means our card can be used right
along with any existing hardware, such as the Sonic Blaster, FutureSound, etc.

Pioneer 2200/4200/8000 video disc control. HyperStudio makes it a trivial process for
anyone to add video sequences to any particular card(s) in a stack. There are over 500 video
discs already in "print", and the number of video disc players is increasing at a tremendous
rate.

Apple II Video Overlay Card. For the ultimate in interactive video, use of the Apple II Video
Overlay Card combines the video image with an on-screen computer image. This lets you
put buttons over the video image, draw arrows, circles, etc. over parts of the image, or put
invisible buttons over parts of the video image, to be clicked on by the user. HyperStudio
has specific control of the Video Card, not just incidental use, which means better control of
"shimmering" on screens that have no video image, good use of color for the paint tools on
cards with video, and the option for truly full-screen video, which includes the screen border
area.

In education, teachers have long wished for good software for their own particular fields of
interest. As a former teacher, however, I realize that time and money are always a lacking
commodity. The problem is that very few people can spend the months of time normally
required to write the software needed for a one-hour lesson. With HyperStudio, we have taken
a dramatic step in the direction of creating a system where the time to create an application is
closer to the time involved in using the application.

Drawing an analogy to written information, when you think about it, you can write (or word
process) at a speed at least somewhat comparable to the speed with which your words will be
read. True, the time to research and organize the information itself is stll a big variable, but the
medium itself (writing or typing) is within an order of magnitude of the time required to view
the output. To date, this is a major barrier in computer information - the time to create the
program is significantly longer than the final application. In some ways, the process is closer
to hand-drawn animation. The only reason most computer applications are practical is because
is because the user is willing to repeat the same basic action over and over again - typing for
example. This means a programmer can spend two months writing a section of code, because
that section will be used thousands of times. When it comes to educational software, where
any given part of a program is only used once, the usage/creation time ratio becomes very
critical.

HyperStudio is a breakthrough product because teachers will be able to create an enormous
number of educational stacks in a time amount that is, for the first time, practical.

Subjects presented with HyperStudio can be done with the teachers's own preferred emphasis
and vocabulary. Highly specialized software such as ESL, safety, drug awareness, etc. is now
an option by using HyperStudio to create the needed material.



8.
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The real signal that a product will be a success is when non-computer owners see a
demonstration, and ask not "How much is the software?", but rather, "How much is the
computer?”. It is this reaction that is responsible for VisiCalc selling the Apple II way back
when, and desktop publishing selling the Macintosh in recent years.

Because of the great impact of color graphics and sound on the Apple IIGS, HyperStudio
could well sell more Apple IIGS machines than even HyperCard has sold Macs. Why?
Because the Mac with HyperCard does show that the basic idea of interactive software, but all
applications are in black & white, with little or no sound (and poor sound quality when used),
and no use of interactive video on-screen with the computer images. Some of these problems
can be solved, but only at costs of $10,000, or more.

Availability of stacks; third party products. The stacks created with HyperStudio can

be distributed by their authors in any way they wish. This can be to other teachers in the
school, other users in a club, or sold as commercial software. We have already been contacted
by a number of private individuals, and commercial software companies, interested in
producing and distributing stacks. CompuServe, Genie and America Online now have
HyperStudio software libraries for exchanging public domain stacks.

Some Users' Groups are already offering member-created disks with HyperStudio stacks as
part of their club library. A2 Central, publishers of the monthly Apple-related newsletter, is
now offering a new publication, Stack Central, which is a HyperStudio-oriented "magazine on
a disk" offering sample stacks, clip-art, articles about what others are doing with HyperStudio
and more. There is also a newsletter, called the HyperLearning Forum, available for
HyperStudio users.

Roger Wagner Publishing, Inc. is also working on a catalog for HyperStudio users that will
feature commercial and public domain stacks, accessory products, and other information.

Special Education. Because of the simplicity of "point and click" operation, HyperStudio

is an excellent tool for the creation of software for computers users with various disabilities.
The ability to easily create stacks with voice prompting and reinforcement, large on-screen text,
animation, and other features makes HyperStudio a very powerful tool. In addition,
HyperStudio has built-in support for the Edmark TouichWindow, which makes it possible to
create stacks for use by very young children, or the general public unfamiliar with using the
mouse to operate a computer. Using the Auto-Activate buttons in HyperStudio, it is also
possible to create stacks that can be operated by simply clicking the mouse button (or other
switch device). This means almost no motor control is necessary to use the computer.

11. Home users with small children. Imagine taking the "Animals" screen from the

12.

HyperStudio disk, and doing a live recording of the animal's name, with an invisible button for
each animal. When a child clicks on each animal, it says the animal name. I've even tried this
with a two year old, and had the child say each word. You should see the absolute delight
when a child hears their own voice from the computer. (Words are insufficient to communicate
the actual thrill - I sincerely suggest you try this with a young child yourself, and judge the
results for yourself!)

New medium for school reports. HyperStudio provides an entirely new way for

students to create reports on a given subject. Rather than the tired, old written report, going
from "Thomas Edison was born in...", and ending with "He died in...", imagine a hypermedia
report where you can hear Edison's immortal "Mary had a little lamb", and explore Edison's
life via the logical connections of various events.






Common Questions About HyperStudio

What is the minimum hardware required?
HyperStudio will run on a now-standard 1Mb Apple IIGS, with a single 3.5" disk drive.
How much memory does it take for a stack?

The biggest factor is whether you imbed sounds in a stack or not. Excluding the sound data, a
10-card stack might use 150K of RAM. Stacks can also be linked together, though, and so the
actual size limit of a particular stack is not very critical. In fact, many people find it easier for a
variety of reasons to break up the actual files into smaller stacks that branch among themselves.
Sound recordings take up about 10K of RAM for each second of the sound. However, sounds can
also be disk-based, so the only memory needed is for just a particular sound as it is being played.

Do I need a hard disk?

We use a hard disk in our demonstrations because of the huge (30 Mb as of this writing) amount of
public domain stacks that we like to have available as on-line as examples of what HyperStudio can
do. HyperStudio is hard-disk compatible, and easy to install, but a hard disk is not required for its

operation.

Do you need HyperStudio to run the stacks? Is a "run-time" version available?

HyperStudio stacks are simply "documents"”. That is, like a word processing file or a picture from |
a paint program, your stack is simply data. Itis not an executable program in and of itself.
HyperStudio is required to make the stack operate.

However, there is a "run-time" version of HyperStudio that has no editing functions, and which
you can use to create disks that you want to give to others who want to use your stacks. For
non-commercial use, there is no fee for using this run-time version of HyperStudio. If you want to
sell the stacks you create, the run-time version can be licensed, much like Apple ProDOS, for just
$100 per year per product.

What are the main differences between HyperCard and HyperStudio?

HyperStudio was not created as a clone of HyperCard, but rather as an expression of what we
thought an Apple IIGS user would expect out of the hypermedia concept. Hypermedia products
from other companies are almost always designed as tools for a programmer, not the non-technical
student or teacher just interested in creating something in a reasonable amount of time.
HyperStudio sits on the shelf next to Print Shop and adventure games, and our audience does not
expect to have to learn programming just to connect two cards and play a sound.

Regarding HyperCard specifically, each program has certain strengths. HyperCard is better suited
to database type operations like searching and sorting, and printing reports. On the other hand,
HyperStudio is much better suited to the general environment of the Apple IIGS with its sound,
graphics, and the general overall computer experience for the user. HyperStudio includes many
functions and options that would have to be bought as add-on products in other hypermedia
products. HyperCard assumes that the user has several megabytes of memory and a hard disk.
HyperStudio is designed for a GS - not a Mac - and is optimized specifically for that machine.

As a few examples, there are kindergarteners creating stacks with HyperStudio, and 4th graders
creating interactive video stacks. We do not believe this would be as likely, if even possible, with
any other hypermedia product.



Can HyperStudio be Site-Licensed?

Yes. HyperStudio is AppleShare compatible, and is a multi-launch application. If you are a school
or business with a number of computers, HyperStudio can be licensed for use on all your
computers at a good discount. Currently, the minimum site-license cost is $375 for five
computers, including all the HyperStudio hardware and your choice of an amplified speaker or
lightweight headphone. Additonal computers after the first five may be licensed for an additional
$75 each with complete hardware, manual and disks, or for $45 per computer without hardware.
Prices per computer are less with larger numbers of computers.

Asa general rule-of-thumb, you can probably estimate that it will cost about the same or even less
to license HyperStudio than AppleWorks.

Is HyperStudio available for other computers?

No. HyperStudio only runs on the Apple [IGS, owing mainly to the uniqueness and power of that
particular machine. No other computer offers the total package of sound, graphics, speed,
memory, etC. at such a cost-effective price. As an example, a complete interactive video station,
including laserdisc player, video overlay card, and touch-screen, can be put together using the
Apple IGS and HyperStudio for well under $4000. On other computers this could cost 2-3 times
as much.

Should I get the Apple IIe-to-Apple IIGS motherboard upgrade?

In our opinion, no. The IIe-to-OGS motherboard exchange costs $500, and does not give you a
new case, 1 Mb of RAM, detached keyboard or mouse. Consider this alternate: Sell the CPU only
of the IIe computer for $400, and buy just an Apple OGS CPU for about $800 (educational
discounts may offer even better prices). Now for $400 ($100 less than the motherboard upgrade),
you've got a "real" GS with 1IMb RAM, keyboard, mouse, and case that fits future accessories.

Even if your budget means you have to use a monochrome monitor and 5.25" drive for a while,
you can upgrade your equipment over time. If you sell your monochrome monitor with the e,
you can buy a Magnavox #3815 RGB Monitor for about $239 mail-order that works fine as a GS
monitor. .

In particular, schools considering new equipment purchases should never buy Ie's thinking
they're less expensive than the GS. It is the color monitor and 3.5" disk drive (and there are $150
AMR 3.5" drives as a substtute) that make the GS appear to be more expensive. At the least,
substitute the GS CPU "under" the IIe monitor and drives you were planning on getting, and you'll
have a faster, more-memory machine that keeps your future options much more flexible.

What kind of cable should I use to connect my tape player or CDROM to the GS
and the HyperStudio digitizer?

Radio Shack stores carry a wide variety of audio and visual equipment cables. The easiest way to
get the correct cable is to take both the HyperStudio microphone and the cables you are currently
getting sound out of your tape/CD with (i.e., the headset, wires to the amplifier, etc.), and ask the
salesperson at the Radio Shack to give you a cable that looks like the HyperStudio microphone on
one end, and the connection for your tape player/CD on the other.

If you already have the HyperStudio speaker ($9.95 from RWP - see coupon in HyperStudio box),
you can use the cable that comes with it to attach most walkman-style tape players and audio CD
players to the HyperStudio digitizer.

What kind of cable do I need to connect the GS to the Pioneer laser disc player?

This is a serial peripheral cable, available from Pioneer dealers. Ask for cable #CC-04.

See the HyperStudio Resource Guide for more information on products that are useful additions to
HyperStudio.



HyperStudio®

Demonstration Kit

This package is provided to assist you in demonstrating HyperStudio to any group. It contains not
only demonstration stacks, but copies of reviews, hands-on scripts for unattended sessions, and
more.

After reviewing the contents of this kit, if you should have any additional questions or comments,
need more materials of any kind, or would like to find out what new demonstration disks, etc. are
available, please contact Roger Wagner Publishing, Inc. at 1-800-421-6526 (619-442-0522 in CA).

Notice: The HyperStudio software included in this Demonstration Kit is not public domain, and
may not be copied without written permission from Roger Wagner Publishing, Inc. If you would
like to make copies of this software for others, sign and return the permission form included in this
Kit. We will complete the form and return it to you, at which point you may make copies for others.

Package Contents:

¢ Disks: HS.System Demonstration version of HyperStudio system disk.

HS.Demo Demonstration version of HS.Demo disk.

HS.Sounds Demonstration version of HS.Sounds disk.

More.Stacks Misc. demonstration stacks.

More.Stacks2 Misc. demo stacks, vol. 2.

Video.Demo Demonstration stacks for various videodiscs.

Com.Stack Lesson on language & communication - 9th grade.

MUG.087 "Read & Listen" stack from Manchester Users Group.

USA This is the beginning of a USA-facts stack. Currently,
information is on Arizona.

HS.Art2 Converted public domain Print Shop graphics, for use

with HyperStudio; downloaded from GEnie.

* Miscellaneous HyperStudio Points

This is a collection of thoughts about HyperStudio, what is unique about it, the value of hypermedia
in different applications, and other ideas that may prove useful to you in answering questions, and
creating the content of your own presentations.

+ Hands-On Script

This booklet is a script provided as a hand-out for those situations where a group of people has
access to an Apple IIGS for a hands-on session for getting to know HyperStudio. Each Apple IGS
should have at least one 3.5" disk drive and IMb RAM. Additionally, if the participants will be
recording their own sounds, the HyperStudio digitizer with microphone will be needed. Each station
should be provided with the HyperStudio disks HS.System, HS.Demo, and HS.Sounds. You may
also want to provide additional sample stack disks selected from the other disks in this Demo Kit.

+ Reviews & Flyers

A sample of the HyperStudio flyer is provided in the kit, along with copies of several other pieces of
literature that may be of value in a presentation. You may duplicate these if you wish. HyperStudio
was also the featured cover story in the September 1989 issue of inCider and was prominently
reviewed in the March 1990 issue of inCider. If you would like copies of these or the color flyers
for your presentation, please contact us and we'll do our best to provide you with anything you may
need.



Special Features: Adding a Video

Adding a video sequence to a stack is easy. In fact, the steps that are about to be described work very
well in a presentation. It is great to show how such an easy process in HyperStudio can give such
dramatic results.

Interactive video in HyperStudio is based on use of the Pioneer 4200 LaserDisc player, and
optionally, the Apple II Video Overlay Card. The Pioneer 4200 is attached to the Apple IGS modem
port, using a simple mcdem cable with the proper connectors on each end. You must make sure your
"Slots" setting in the Control Panel has Slot 2 set to "Modem", and the "Modem" setting is set to
4800 baud.

To add a video sequence to a card in a stack, do the following:

First, choose New Card from the Edit menu. (If the screen does not erase, immediately press
Apple-E to erase the new screen. This makes it obvious to those watching that a new card has been
created.) Before proceeding, make sure that a Pioneer 4200 (or compatible) video disc player is
attached to the modem port of the Apple IIGS, a disc inserted, and the player in the "Play" mode.
(The control panel for the Modem Port should also be set to 4800 baud).

Now choose "Add a Card Video" from the Objects menu. A dialog box will appear that asks whether
you want a Full Screen Video, or a Partial Screen Video. For the moment, choose Partial Screen.

If you have the Apple II Video Overlay Card (VOC), HyperStudio will then display a rectangle, with
handles, that can be re-sized and positioned as you wish. This rectangle determines exactly what
portion of your video image will be displayed on the card. Changing the size of the rectangle does
not fit the entire video image into the new rectangle. Rather, this is just a "window" onto the video
image produced by the videodisc player. Also displayed will be a video disc remote control display.
When dragging the rectangle, wait just a moment after pressing the mouse button to give the software
time to hide the remote control display, before moving the mouse. Also, you'll have better results if
you position the tip of the arrow cursor on the actual corner of the video rectangle frame, rather than
grabbing the comer rectangles themselves.

If you don't have the VOC, you can still use HyperStudio to bring up a given image or sequence in
connection with any particular card. If there isn't a VOC in the computer, HyperStudio will display
the remote-control box on the screen, but will not put a rectangle on the screen. In this case you
would use a second TV or monitor to display the output from the videodisc player.

A video sequence is defined by specifying the beginning and end frame numbers of the video to be
shown when the current card is displayed. The radio button starts on the "Begin" setting. Click on
the Play, Scan or Step buttons to find the beginning of the sequence you want to use. If the disk is
Playing, clicking on Step or Pause will stop the disk on that frame, and update the frame number
register with the current frame number. You can also press the Clear key on the Apple keyboard, and
enter a new frame number. The player will then jump to that frame. To set the ending frame, click
on the "End" radio button, and then click on Play to let a few seconds of video roll by. If you don't
have motion video available, just leave the End frame # the same as the beginning.

You can test your video by pressing the Test button. When you get the sequence you want, just click
on the Keep button.

That's it! Now, whenever this card is displayed, the video sequence will be shown as well. To test
this, just press Apple-B (or choose Beginning card from the Move menu) to move to the first card in
the stack. Now press Apple-N (or choose Last card) to move back to your card with the video image
attached. The video image will be displayed as you defined it.

A video sequence can also be attached to an individual button, rather than a card. The difference is
that the video will only be shown when that button is pressed, rather than immediately when the user
moves to a given card.



Creating a Full-Screen Video

In normal use, the video image (with the Apple II Video Overlay Card) will only show through the
region defined by the video rectangle used when Adding a Card Video. However, the Video Overlay
Card works by defining a color as the "key-color", or "show-through color" on the screen. Before a
video is added to a card, the key color is purple. The purple hue on the screen changes to a pure blue
once a video object has been added to a card.

There are two degrees of "full-screen” on the Apple IIGS. The first is the active screen area,
excluding the border area. The larger full-screen includes the monitor border area as well. You can
design a card to use either method.

If you want to create a video image that fills the entire background of a card, you can do this by
painting the entire card background with the proper show-through color. The color to choose for
filling the background will either be purple or blue, depending on whether a video has already been
added to a given card, but its position in the color table will always be the same: color #6. That is, in
the "Colors" menu, choose the second color from the left in the second row from the top. If you are
using the "Set Background Color" menu option (Options menu), use the 6th color choice from the
left.

When your video image is displayed, the video will be seen across the entire screen, regardless of the
actual video rectangle. In most cases, you'll find it easier to just make the video rectangle as small as
you can, and then move the video rectangle to some out-of-the-way spot on the screen (but still over
an active video show-through area).

If you want the video image to fill the screen border area as well, then click on "Yes" when first
adding a video, when you see the dialog box asking if you want to show the video in the screen
border area. The only real difference between these is that HyperStudio changes the GS border color
to the "key-color”. This will allow the video image to go to the absolute edge of the monitor screen.

The advantage of using the background graphic itself (as opposed to the video rectangle) for the video
show-through area is that it is easy to re-paint a rectangle or other area if you want to change the
image area. In addition, you can use the Add clip-art, or other paint tools, to overlay labels, arrows,
or icon-buttons onto your video image. You should also try drawing some rectangles, with "draw
filled" checked in the Options menu, in various colors. You'll notice that colors range from
completely transparent (blue) to completely opaque (black, white, grey, and shades of red), and
others are in-between. This can create very neat effects that show a dimmed image of a larger video
image, with a certain part "highlighted" by being 100% transparent, and thus brightest.

The real key here is to just experiment. You can't hurt anything, and you're likely to discover many
useful techniques in the process. Also remember to experiment with using the paint tools to create
small windows with video showing through. We've found that although the video rectangle is the
easiet to explain and use for beginning users, in the long run, using the paint tools will give the most
flexible results.






How to Use This Kit

The Standard Package: (This applies only if you are using the complete package in your demo)

The standard HyperStudio package currently includes four disks (HyperStudio startup disk,
HS.Demo, HS.Art and HS.Souuds), a digitizer card and a microphone.

The easiest way to start learning about HyperStudio is to simply start up the HyperStudio disk, and to
click on the "Intro" icons. After going through the Introduction stack, explore the other stacks in any
order you wish.

After looking through the stacks, we suggest you go through the HyperStudio manual, installing the
sound hardware, and working through the tutorial.

Explore The Extra Disks

Although HyperStudio has only been out a short time, people are already starting to create a wide
variety of applications, and many of these stacks are available in the public domain.

A number of disks have been provided to you, as part of this kit, that are a sampling of what people
have created. Some are very simple, and others are fairly complex. In all cases, the stacks were
created by people who have only had a short time using HyperStudio. We think you'll be impressed
by what can be created with very little experience.

The main sources for these stacks were modem services: GENIE, CompuServe and America Online.
Some users groups are also starting to create disks with HyperStudio stacks that are quite good.

To examine any of the disks, go to the File menu, and choose Open Stack. Then insert the disk
you're interested in, and click on the Disk button in the file selection dialog box. When the list of
files appears, you'll see (in most cases) a Home.Stack (or similar sounding file). Choose that, and
then use that Home Card to examine the various stacks available. When you want to examine a new
disk, go to the File menu and choose Load Stack again. Find the Home.Stack on the new disk, and
go from there.

A few disks only have one stack on them, and so don't have a Home.Stack to load. These exceptions
are noted for each disk, and the file listedwould be opened to use the stacks on the disk.

Disks to look at:
More.Stacks: (load Home.Stack)

Stack Description

HyperBrain Shareware science stack on the human brain.
Solar System Science stack on the solar system.

Mouse Maze Move the mouse through the maze.

Optical [lusions Quick tour of common optical illusions.

More Stacks2: (load Home.Stack)

Birds Short example of notebook-style stack with digitized pictures done
with Computer-Eyes video camera digitizer.

Cat Chosen specifically for its simplicity. Using the child's own voice
can make even the simplest stack an effective tool.

Chessmoves An introduction to the rules of chess.

Computer.Stack An introduction to the parts of the Apple IIGS.



Hypermagic The Apple IIGS can really do magic with HyperStudio.
Com.Stack: (load Home.Comst)

This is really one stack. It is a lesson on language and communication created by a ninth-grade
English teacher.

MUG.087: (open Reader.Stack directory, and load Read.And.Listen)

A very nice stack done with all the members of the family contributing. MUG is the Apple
Manchester Users Group, and this disk is one of their club disks.

Video.Demo (load Home.Stack)

Video.Demo is a special demonstration disk that has stacks showing the use of interactive video with
HyperStudio. On this disk are stacks that have been designed around five specific video discs. This
is one of the most powerful demonstration tools available, not only for HyperStudio, but for the
Apple IIGS, and also the Apple II Video Overlay Card. If you do not have a Video Overlay Card,
you can still use the video demos, but you will need a separate monitor for the video images.
HyperStudio requires a Pioneer 4200 video disc player (or compatible) for the video stacks.

To use this disk, at least one of the following video discs is also required: The '88 Vote, from ABC
News; Voyager Gallery, from Optical Data Corp.; BioSci Video Disc, from Videodiscovery; and/or
Greetings From Earth, from Video Vision Associates, Ltd. "Greetings from Earth" is no longer in
print, but is a popular disc, and can still be found, and at a reasonable cost, in record stores that stock
video discs. Even if you don't have any of these titles, you should still try at least one of the stacks,
just to get an idea of how they work. Although the video image shown with a particular card in the
stack may not be correct, you will still be able to demonstrate to yourself that HyperStudio is properly
retrieving a given frame number or moving sequence for each card.

USA (load USA.Home)

This is a stack recently begun by a HyperStudio user in Arizona. Done for his children, it is the start
of a stack that will feature facts about various states of the U.S. Currently, the stack only has
information on Arizona. Click on Arizona when you see the U.S. map. This really is a very nice
stack, and will give you some good ideas. If you click on the Grand Canyon on the map of Arizona,
you'll hear some theme music.

HS.Art.2 (to use in a stack, select either load a background, add clip-art, or add
graphic)

This disk is converted public domain Print Shop GS clip art that has been downloaded from bulletin
boards, changed to 640 mode graphics and colorized.
Going Home...

Remember, even if the stack you're in doesn't have a Home Card icon, you can always press
Apple-H (for "Home") to return to the last stack loaded that actually has the name "Home.Stack".



HyperCard offers "scripting", which is a programming language that is used to define the actions
on each card. HyperStudio is "auto-scripting”, and almost entirely menu and dialog box operated.
However, for those who do need the additional power of a programming language, HyperStudio
Extended Commands can be written in Pascal, C and assembly language, and sample source files
are provided in the package.

Can you read Macintosh HyperCard stacks?

The Macintosh stacks are a completely different type of document, and so are not readable by
HyperStudio. In addition, many HyperCard stacks use Extended Commands written in 68000
code, which can only run on a Mac. The screen resolution of the Mac is also different (which
would result in distorted screen images when run on the GS), and many Mac stacks assume 2-4
megabytes of RAM and a large hard disk.

Do I need a LaserDisc player and Video Overlay Card to be able to use
HyperStudio?

No. These items are shown in presentations to demonstrate how well HyperStudio integrates much
of the existing "universe" of computer add-ons for the Apple IIGS. However, they are entirely
optional.

The Apple II Video Overlay Card is also not required to use interactive video with HyperStudio. If
you don't have the VOC, then a second monitor can be used alongside the GS monitor to display
the video image. When running a stack that has images that would otherwise use the VOC,
HyperStudio automatically skips the display if the VOC is not present.

Which videodisc players does HyperStudio work with?

Currently, HyperStudio works with the Pioneer 2200, 4200 and 8000 laser disc players.
However, we are currently working on "drivers" for quite a number of other laser disc and VCR
players.

Can I use graphics from PaintWorks Plus (or other 320-mode Super Hi-Res
graphics) programs?

HyperStudio operates in the 640 Super Hi-Res mode of the Apple IIGS, which is different from
the 320 mode. Older graphic programs like PaintWorks Plus used the 320 mode. Most current
programs like AppleWorks GS and PaintWorks Gold use the 640 graphics mode.

HyperStudio can display a 320 mode graphic as a full-screen image on a card, and invisible buttons
can be placed on the card. Itis also possible to convert some graphics using the RWP program,
"The Graphic Exchange".

Where can I get more stacks?

The biggest sources of stacks currently are the on-line modem services such as America Online,
CompuServe and GENIE. However, many user groups are now starting to add HyperStudio
stacks to their club libraries, and these are usually available at a very low cost ($5 or so). There are
also commercial developers developing stacks for HyperStudio, and RWP has a catalog planned
listing not only available stacks, but accessory products, such as digitizers, speakers, etc.

There is also a newsletter called the Hyperlearning Forum, with monthly information on
hypermedia and education, and a bi-monthly magazine-on-a-disk called Stack Central that has
stacks, clip-art, articles, etc. See the HyperStudio Resource Guide for specific details on these
sources.

The Big Red Apple Club, 423 Norfolk Ave., Norfolk, NE 68701 (402) 379-4680, has stacks for
sale as well.






A Hands-On Walk-Through

In this hands-on session, we'll take a look at the HyperS tudio® software, try an existing sample
stack, and let you experiment a little with creating your own stack.

The computer you are working on should have a minimum of 1Mb memory, an Apple 3.5 disk drive,
and a small microphone. You should also have three disks marked as follows:

1) HS.System
2) HS.Demo
3) HS.Sounds

Step 1: If the computer system has not already been started up for you, insert the disk marked
"HS.System" in the disk drive. Then, to restart the system, hold down the Control and Apple keys,
and while still holding them down, press and release the RESET key. The RESET key is the key
above the top row on the keyboard, just to the right of the Apple logo, and marked with a small
triangle.

When you release the RESET key, the disk drive should come on, and the HyperStudio software will
be loaded from the disk. If you haven't already done so, you can now release the Control- and
Apple-keys.

Step 2: After a little while, the HyperStudio title screen will appear, and shortly thereafter, a screen
called the "Home Card" will appear. This screen has the name "HyperStudio” across the top, and is
the starting point for using most HyperStudio applications. A good place to start is with the "Intro"
stack. To start using the Introduction stack, just use the mouse to position the hand cursor over the
picture of the handshake, labeled "Intro", and click the mouse button once.

You will then be prompted to insert the disk HS.Demo. If you have two 3.5" disk drives, insert the
disk labeled HS.Demo in the second drive and press Return. If you only have one 3.5" disk drive,
remove the disk HS.System from your drive, replace it with HS.Demo, and then press Return.

The Introduction stack should take about 5 minutes to work your way through. In the process, you'll
get an introduction to both HyperStudio, and the Apple IIGS.

When you have finished the Introductory stack, you will be delivered back to the Home Card. From
there, you'll want to look at the stack "Read.Me", which answers a number of common questions
about HyperStudio. After that, you can click on any of the other stack icons to explore the many
different uses of HyperStudio.

By now you should have a general idea of how HyperStudio operates using stacks of computerized
cards. You should also have observed how buttons are used to move between cards. To try your
hand at creating your own stack, read on to the next section.



Creating a Simple Stack

One of the best things about HyperStudio is that not only can you run hypermedia applications
created by others, but you can also use it to create your own computer programs for yourself,
friends, family or school.

Students and teachers both will find hypermedia a new and and exciting way to create a new version
of the traditional report.

Teachers using HyperStudio can create their own educational software with a minimum of time, and
no knowledge of programming is required.

Any stack is simply a series of cards, on which are placed various objects. These objects can include:

o Text

 Graphics

 Buttons

* Video overlay frames
e Sounds

Each card in a stack has a background. You can use the paint tools to draw your own, or import an
existing graphic from your favorite paint program (Paintworks Gold, Deluxe Paint I, 8/16 Paint, and
others), or graphics library. The buttons are used to move between cards, or to trigger certain actions
like the playing of a sound or an animation sequence.

In a moment, you'll create your own stack. The steps you'll be following to create a stack are fairly
simple. A complete set of directions is provided in the following pages that will show you how to:

1) Choose New Stack from the File menu.

2) Create a series of cards with the desired backgrounds.

3) Add information to each card in the way of text and graphics.

4) Add buttons to move between cards, or trigger actions on a card.

Since cards can be added anywhere in a stack, moved from one position to another, deleted, copied,
and in general manipulated in many ways by the computer, you can use the computer itself to help
you organize your thoughts. In general, you'll get off to a better start if you try to conceptualize your
project as well as you can before beginning, but HyperStudio is flexible enough to let you change
things as you go along.

For our first stack, let's suppose you wanted to create a stack like the "Spanish" stack, that teaches a
foreign language.

Step 1: The first step in creating your own stack is to clear the current stack in memory from the
computer. To do this you will need to use the authoring mode of HyperStudio, and its pull-down
menus. If the menu bar is not already visible on the screen, simply press Apple-M to bring the
menu bar into view.

Now, use the mouse to pull down the File menu, and choose "New Stack". The screen
will clear to white, and the computer is ready for the creation of a new stack.

Step 2: An important step in creating a stack is to decide roughly how many cards you'll have in

your stack and what you want them to be. For our example stack, we'll start with a map of the world

as the first card. The next card will be a scene of a plaza, with various things typical of a foreign

}jc;c;ation - a passport, room keys, taxi, etc. In this background, we've even included a guitarist and
cer!

a. To load the first background, go to the File menu again, and choose Load Background. The
standard file selection box will appear. If you have two drives, the first directory shown will be that
of the HS.System disk, which does not have any graphics on it. If you aren't already looking at the
directory for the HS.Demo disk, use the mouse to click on the "Disk" button to switch to the



HS.Demo disk.

Once the HS.Demo directory is shown, use the mouse to select (highlight) the file "World.Map".
As a short-cut, you can also press the "W" key.

When the file World.Map is highlighted, press Return, or click on the Open button. You can also
just double-click on a file name to load it. The screen will then fill in with the picture of the world
map. This is the background for your first card.

b. Before adding buttons and sounds, remember that we need to create the second card, and load the
graphics background for it. Go to the Edit menu, and choose "New Card". The screen will
clear, and the upper-right corner of the screen will now read "Card 2".

c. Load the background for the second card by again choosing Load Background from the File
menu. This time load the picture file "Spanish.Pic", also located on the HS.Demo disk.

d. You have now created two cards, each with a unique background. To move back to the first
card, pull down the Move menu, and choose First Card. This will move you back to the first
card, which has the picture of the world map.

Step 3: Now you can add some objects to the first card. Let's add a button. Go to the Objects
menu, and choose Add a Button.

a. The first dialog box will show you a selection of standard button styles, and to the right, the
choice "Invisible". For now, click on the square button, with the small shadow. To add

text within the button, just type on the line provided. For this button, type "Mexico", and press
- Return (or click on the OK button).

A dialog box will appear explaining that the next step is to drag the button to the desired position.
Click on "Continue" after reading the instructions.

b. The button will now appear in the upper-left corner of the world map. Put the arrow cursor over
the middle of the button and hold down the mouse button. Then move the mouse to drag the button
to a new location. Use the mouse to position the button just to the left of where Mexico is located
on the world map. Release the mouse button, and then click outside of the button, anywhere on
the world map, to tell HyperStudio you're finished positioning the button.

¢. The next dialog box that appears is provided to let you specify what action should be taken when
the button is pressed. Under "Connect to:", is a list of possible "targets" that HyperStudio will move
to when the button is pressed. Since we want this button to move to the next card, the one with the
spanish scene, click on "Next Card", at the top of the Connect To list.

d. The next choice you get is what type of visual effect, or transition, you want when the user moves
to the new card. You've probably seen a number of these transitions by now, in the example stacks
of the Home Card. For this transition, choose "Left to Right", and click on the "Ok" button (or
press Return). As you create your own stacks later, you'll want to experiment with the different
transitions to see how they look.

f. Once that's done, you're back at the button actions section. In addition to moving to another card,
you can still decide whether you want a test score kept ("Test functions"), and whether a sound
should be played, or an animation started. For now, just click on "Done" (or press "Return").

g. Now let's work on the second card in your stack. You could use Next Card in the Move menu to
move to the next card, but you can also just use the button you defined. Click on the "Mexico"
button to move to the spanish scene.

h. On this card, we'll put an invisible button that plays a sound. The first sound will be for the
passport, in the lower-right comner of the screen. Since you're adding a button, go to the Objects
menu, and choose Add a Button.



i. This time, choose Invisible button, and press Return. You don't need to enter a name for
invisible buttons. Now, instead of a standard button to place, you'll see a twinkling rectangle. This
represents the "hot spot" that will act like a button when the user clicks with the mouse. In this case,
you want to make the rectangle the same size as the passport, and covering the passport image.

j. Drag the shimmering rectangle towards the passport by putting the mouse cursor inside

the rectangle, pressing the mouse button (hold it down), and dragging the rectangle until its
lower-right corner is aligned with the lower-right corner of the passport. Release the mouse button
when the rectangle is positioned. To resize the rectangle, put the tip of the arrow pointer on the very
upper-left corner of the shimmering rectangle. Press the mouse button, and drag the mouse down
and to the right until the rectangle is roughly the same size as the passport. If you make a mistake
trying to drag the very comer of the rectangle, just choose "Cancel” when the next dialog box
appears, and try again (go back to step "h"). You want to position and size the rectangle so that it just
covers the passport.

k. As before, to tell HyperStudio you're finished positioning and sizing the rectangle, just click
outside the rectangle somewhere. You'll now get the same dialog box of "button actions" as before.
This time, leave the "Connect To:" setting to "No Connection", and click on "Play a sound...".

l. You'll now be given the choice as to whether you want to record the sound now, or use a Disk
File. Click on Disk File. The standard file dialog box will then appear. If you are using two 3.5"
disk drives, it will first show the files on the HS.System disk. If so, click on the Disk button to
show the files on the HS.Demo disk. We have included a pre-recorded voice of the spanish word for
passport on the HS.Demo disk.

m. When the files on the HS.Demo disk are listed, press "P" to highlight the file
"Passport.Span", and press Return (or click on Open).

n. A "tape recorder” screen will now appear with a vertical slider labeled "Volume", and two active
buttons labeled "Play” and "Stop”. Use the mouse to click on the Play button to hear the word. You
can adjust the volume by moving the vertical slider, and clicking on Play again. When you've got the
volume where you want it, click on "Done" (or press Return).

0. You'll now be back at the "Button Actions" dialog screen. Since you've finished specifying the
button actions, just click on "Done". ‘

p. The card will now reappear. If you now click on the passport, you should hear the spanish word
for passport!

Trying It Out

To try your stack out, choose First Card in the Move menu. Then click on Mexico. When the
spanish scene appears, click on the picture of the passport to hear the spanish word.

That's it! You've now created a simple stack! If you have extra time after completing the examples
so far, you can try adding another invisible button for the dancer, and use the sound "Girl.Spanish".
You can also add other visible buttons to the first card, for South America and Spain, if you wish.
Try other transitions as you move to the "Next Card".

If you're really ambitious, you can combine moving to the spanish scene with a bit of music during
the transition. To do this, simply click on "play sound" in the button actions menu, then on "Disk
File". Finally, specify Music.1a as the sound to play. Now, when you click on your Spain or South
America button, you should hear some music as you move to the spanish scene.



Recording Live Sounds in HyperStudio

One of the other great things about HyperStudio is that you can add sounds to a stack right while
you're creating it! The digitizer card and microphone let you record "live" sounds right on the spot.

To try this out, let's add the words "un taxi" as a response to the picture of the taxi in the spanish
scene.

With your own spanish stack still in memory, go to the spanish scene, and create an invisible
button that just covers the taxi cab. Remember to click outside the rectangle when you're done
positioning and sizing it. When the button actions dialog box appears, click on Play a Sound.
This time, click on Record Now to tell HyperStudio you want to record a live sound.

When you click on Record Now, the tape recorder will immediately appear.

Speak into the microphone before doing anything else; you should see a green bar flicker in the Level
window. Try saying "Un taxi" (the "un" is pronounced like "oon") a few times to get the feel for
how loud you have to speak to get the green bar to jump reasonably well as you speak. Be sure to
hold the microphone close to your mouth to get a good strong input for the microphone.

When you're ready to record, use the mouse to click on the Record button, and say the words “Un
taxi." Press the space bar (or Return) after you've said the phrase. (This stops the recording
process). Now click on the Play button to hear your recording. It may sound a little quiet, so try
using the mouse to drag the volume indicator a little higher, and click Play again.

If you want to try to get a better recording, click on Erase once, then on Record, and repeat the
phrase. Notice that when you click on the Record button, the screen border will turn green when
HyperStudio is ready for you to start speaking. When it hears the first sound, the border will turn
red, telling you it is recording your voice.

When you have a reasonably good recording of "Un taki", click on the Done button to return to
the button actions menu. Then click on Done to return to the spanish scene.

Now, click on the taxi to hear your voice in the stack. In normal use, you could save your stack by
simply using "Save As" in the File menu. For this demo, this won't be necessary. To go back to the
Home Card, go to the Move menu, and choose Home.

At this point, and if you have not done so already, we suggest you explore some of the various
demonstration stacks on the HS.Demo disk to get an idea of what is possible with HyperStudio. For
this hands-on session, the presenter may also have provided extra disks, not normally included in the
HyperStudio package, with many other demonstration stacks that you may find interesting.

The next section describes some of the additional stacks that may be available. In general, these
stacks were obtained from online modem services, such as CompuServe, GEnie, and America
Online. Some stacks were also sent directly to Roger Wagner Publishing, Inc. by HyperStudio
users, or came from user group library disks.



Other Stacks

Although HyperStudio has only been out a short time, people are already starting to create a wide
variety of applications, and many of these stacks are available in the public domain.

A number of disks have been provided to you as part of this introduction to HyperStudio that are a
sampling of what other people have created. Some are very simple, and others are fairly complex. In
all cases, the stacks are created by people who have only had a short time using HyperStudio. We
think you'll be impressed by what can be created with very little experience.

The main sources for these stacks were modem services: GENIE, CompuServe and America Online.
Some users groups are also starting to create disks with HyperStudio stacks that are quite good.

To examine any of the disks, go to the File menu, and choose Open Stack. Then insert the disk
you're interested in, and click on the Disk button in the file selection dialog box. When the list of
files appears, in most cases you'll see a Home.Stack (or similar sounding file). Choose that, and
then use that Home Card to examine the various stacks available. When you want to examine a new
disk, go to the File menu and choose Open Stack again. Find the Home.Stack on the new disk, and
go from there.

A few disks only have one stack on them, and so don't have a Home.Stack to load. These
exceptions are noted below.

When you're done, go back to the Home.Stack on the HS.Demo disk, so the next person can start
from the beginning.

Disks to look at:

More.Stacks: (Open Home.Stack)

Stack Description

HyperBrain Science stack on the human brain.
Solar System Science stack on the solar system.
Mouse Maze Move the mouse through the maze.
Optical Ilusions Quick tour of common optical illusions.

More Stacks2: (Open Home.Stack)

Birds Short example of notebook-style stack with digitized pictures
done with Computer-Eyes video camera digitizer.

Cat Chosen specifically for its simplicity. Using the child's own
voice can make even the simplest stack an effective tool.

Chessmoves An introduction to the rules of chess.

Computer.Stack An introduction to the parts of the Apple IIGS.

Hypermagic The Apple IIGS can really do magic with HyperStudio.

Com.Stack: (Open Home.Comst)

This is really one stack. It is a lesson on language and communication created by a ninth-grade
English teacher.

MUG.087: (Open Reader.Stack directory, and Open Read.And.Listen)

A very nice stack done with all the members of the family contributing. MUG is the Apple
Manchester Users Group, and this disk is one of their club disks.



HS Presentation Tips

The following information is provided to help those who will be presenting HyperStudio to user
groups, conferences, workshops, etc. For the person just showing HyperStudio to their neighbor or
a few associates at the office, this all may seem a little overwhelming. The information is intended to
be of greatest benefit to those who would be presenting HyperStudio to a large group of people.

Equipment:

Computer: A 1Mb Apple IIGS (now the standard model), with ROM version 03, or the older
1.25Mb ROM 03 is quite sufficient, although there are a very few stacks around that were created on
larger memory machines. 2Mb of RAM is more than sufficient to run any HyperStudio stack we've
seen to date. Larger memory does mean you have to worry less if you're embedding lots of sounds
and graphics during your presentation. When preparing ahead of time, you can always use the Stack
Info menu choice in the Objects menu to see how much usable memory you actually have available
while you're working on your stack, and estimate how much can be added (in the way of new
sounds and graphics) to a given stack.

Disk Drives: HyperStudio is designed to operate on a standard 1Mb Apple IIGS with a single disk
drive. However, if you can have two 3.5" drives, you'll have to swap disks much less frequently.
A hard disk is not required, but if you want to show more stacks in a given amount of time, having a
large on-line disk makes it easy to keep various examples on hand to quickly follow the interests of
your audience.

Display: The GS monitor is actually sufficient for small groups (half-dozen people or so), but a
larger display is always a plus. The RCA phono jack (located just below the power cord at the back
of the GS, with a small picture of a monitor screen above-it) can be connected directly to the "Video"
input on many large color monitors found in classrooms or as part of audio-visual equipment that
may be available to you. For groups up to 20-30, this may be sufficient.

If a true monitor input is not available, the video output from the RCA phono jack may be connected
to an RF Modulator, available from Radio Shack for about $30 (part #15-1273A), that will convert
the computer video signal to a Channel 3 or 4 TV output. This can then be connected to the VHF
antenna connector on any TV. Although the text will not be as sharp and readable as on the GS RGB
monitor, remember your audience is, for the most part, just following your general actions, not trying
to read volumes of text on the screen.

Of course, better quality is always desirable where possible. Another enhancement is to use the
Apple II Video Overlay Card (VOC). This has both a monitor (NTSC) and a RGB output on it. The
RCA phono jack on the VOC has a better video signal than the built-in jack on the GS mentioned
above. The video from the VOC RCA jack would be connected to the "video in" jack on a color
monitor, or can be connected to the Radio Shack RF Modulator.

Avoid entirely using the LCD panels that are placed on an overhead projector. These are black &
white only, and frequently have an alm.ost unrecognizable image when trying to show GS graphics.
It is better to use a large-screen TV for a group of 100 or more than to use an LCD screen.

The best device we've seen to date was a device previously marketed by Kodak under the model #
LCS00, a color projection device (cost about $3000), now marketed by Epson. The Sony and
Electrohome large-screen projectors also work very well when you can get them.

Sound: For small groups (6-12), the RWP battery-powerd amplified speaker may be sufficient. The
internal GS speaker is just not powerful enough to be heard very well in a group setting. The sound
quality of the GS is almost entirely a function of the speaker used. The internal speaker greatly
under-represents what the machine is capable of.



One alternative is to use the Radio Shack RF modulator mentioned earlier. This also has a sound
input jack on it that will mix the video from the computer and play both the picture and the sound
from the GS through a TV speaker.

Radio Shack and other stores also offer amplified speakers that cost much less than the BOSE model
speakers promoted early on with the GS. We use Yamaha DM-01 amplified speakers, which were
priced at about $100 for a pair, and have 30 watts of output power. They are quite sufficient for
almost any size room. Unfortunately, these are no longer made by Yamaha. We mention it because
they're worth picking up if you do happen to get a chance. Pay particular attention to the power rating
(i.e., xxx watts) when choosing a set of amplified speakers. The RWP battery speakers are 1/2 watt.
Speakers with their own volume control are to be greatly preferred, especially if used with a laserdisc
player which has no volume control of its own. :

Although the GS only needs one speaker for the sound output from HyperStudio, two speakers are
needed if you will be using a laserdisc player also, since that device has its own independent sound.
We've found that a Radio Shack Stereo Mixer (#32-1100A, about $60) lets us mix together the
output from the GS, both channels of a laser disc player, and a lapel microphone (for you, not the
HyperStudio digitizer card), and easily control the volume of each channel. The output can then be
sent to two amplified speakers, or set to mono and connected to the RF Modulator to be ultimately
played by a TV or monitor.

Note: the audio output from the GS and the laserdisc player are connected to the "Phono (cer)" inputs
on the Mixer. A lapel or handheld microphone, if used, is connected to the Mic input on the Mixer.

Laserdisk Player: For a truly dynamite demonstration of just how much an Apple IIGS an do
when equipped with HyperStudio, be sure to include a laserdisc player. HyperStudio supports
Pioneer models 2200, 4200, and the 8000. These players are likely to already be available in many
schools, and a local video or Apple dealer may also be quite ready to loan a unit for a presentation to a
group. (They certainly will be after they've seen what HyperStudio can do for demo'ing their unit!).

The laserdisc player is attached to the Apple IIGS with a simple modem cable (DB19 on one end,
Mac/GS mini-din 8 on the other). Make sure the GS "Slots" in the Control Panel is set to "modem",
and that the "Modem" setting has been set to 4800 baud.

Apple II Video Overlay Card (VOC): If you are going to show the laserdisc player, then you
really should try to get the VOC as well. Again, many schools already have this, and most dealers
should be eager to lend you one to demonstrate to a group as well. What the VOC does is quite
simple: it just mixes the video signal from the laserdisc player (or any other video source like a video
camera, etc.) with the graphic computer image right on the GS monitor. The final effect, however, is
quite powerful. On one screen, you'll be able to have live-action video with overlayed HyperStudio
buttons, text labels, etc. The Apple IIGS with HyperStudio is currently the most cost-effective and
still very powerful interactive video platform available.

Before you start up HyperStudio, the Video Overlay Card will default to a show-through color of
black, which will make the finder look a little strange if the video player is turned on. However, once
you've started up HyperStudio, it will take control of the Video Overlay Card, and everything should
look much better.

Again, remember the video output from the Video Overlay Card is better than that from the GS, and
so can also be used to output a cleaner screen image to a large-screen color monitor or to a TV via the
Radio Shack RF Modulator. The "Video.Demo" disk in the HyperStudio demo kit has demos
specifically for laserdiscs and the Video Overlay Card.

By the way, most audiences are quite interested to know that the video output from the GS with or
without the VOC can be connected directly to a VCR for creating their own movies using
HyperStudio as the controlling software.



Accelerators: The operating speed of a standard Apple IIGS is quite sufficient for HyperStudio.
However, if you do have the Applied Engineering Transwarp GS, HyperStudio will work just fine
with it. Just remember to set "AppleTalk/IRQ: On" in the Configure menu of the Transwarp GS
control panel desk accessory. Otherwise, playback of sounds you record in HyperStudio may play
back at a too-fast rate. The big advantage to having an accelerator for a presentation is simply that it
lets you show that many more stacks, etc. by saving a few extra minutes in an hour presentation.

Edmark TouchWindow: This touch-screen overlay for the computer monitor was first marketed
by the Personal Touch company some years ago. Almost every Apple Educational Representative
has one in their boxes of goodies. The TouchWindow connects to the Apple IIGS game connector,
and is turned on with a simple menu choice in the Preferences menu of HyperStudio. Once activated,
HyperStudio stacks can be operated entirely by touching the screen to activate buttons. This shows
particularly well in stacks like the Spanish lesson and Read & Listen. TouchWindow operation can
be useful for both preschoolers who haven't mastered the mouse yet (we've seen stacks being used
by 2 yr-olds this way), and for situations where people who have never used a computer before are
using a stack. For example, such as in a Visitor Information setup in a hotel or museum. Once you
try it, you may find you like the TouchWindow for running all your HyperStudio stacks. It's
actually a pretty good alternative to the mouse in this particular application.

Note: Although normally mounted with Velcro to the Monitor, we've found that two large rubber
bands do a pretty good job of holding the TouchWindow to the front of the GS monitor, and it's then
very easy to move the TouchWindow to other monitors, for packing, or whatever.

Using Equipment That's Provided: In many cases, it is great if you can get the place you're
presenting at to provide things like a laserdisc player, video projection system, etc. However, it is in
the end far better to always assume your own computer, disk drives, etc. will be what you are using.
This is for two very important reasons: First, despite the best planning, there are many times when
you will arrive, and a crucial piece of equipment like a monitor, power-strip, extension cord, etc. will
not be available. Second, although rare, there is an occasional great variation, especially in the early
model GS computers, in the sound quality of the sounds recorded and played back with
HyperStudio. This is not a fault of the HS system, but rather a wide range of operation in an
occasional model of the computer itself. Since very few programs actually use the sound
synthesizing ability of the GS, it is not unheard of to arrive at a presentation where a machine has
been provided, only to discover that the sound circuitry is defective on that machine. When you
bring your own equipment, you know for sure that everything will operate correctly at each stage of
your presentation. Helpful tip #37: be sure to tape your business card or a mailing label with your
name on it to each piece of your computer equipment, including disks, laserdiscs, etc. (even on your
cables). It's surprising how all the disk drives look alike when somebody puts them in a big pile at
the back of the room, and in general this helps avoid other people accidentally picking up your
equipment as well.

Bottom line: Be prepared for anything! If you always take along a box or bag that has an
extension cord, multiple outlet power-strip, extra long video cables and an RF Modulator for
emergency use of handy TVs or large-screen monitors, you'll be guaranteed your presentation will go
the way you want. If you're using a hard disk, always carry at least the four main HyperStudio disks
so that you can use the 3.5" drive on the GS if the hard disk should decide to arrive in a non-working
state.

If you do have to use another computer, it is also useful to know that you don't have to always bolt
the HyperStudio digitizer card inside. If you're in a rush for time, you can use the plastic bag the
digitizer card comes in to insulate the board from metal parts inside the computer case. Feed the
microphone wire in through one of the cutouts in the back, and lay the card inside the plastic bag on
top of the power supply. Bolting the card in does improve grounding, and sound quality in noisy



computers, but not having to take the time to bolt the card in can be handy sometimes, especially if
you are setting up a lab of 10-20 computers for a temporary workshop.

Topic/Flow Suggestions

The best way to show HyperStudio is to simply share with other people what you've been doing
yourself with the product. Your own interest and enthusiasm will count for a lot, and in many cases
mean a lot more than some of the slick, but obviously canned presentations you've probably seen
others do.

However, the following points are provided as ideas that we've developed in the course of showing
HyperStudio to many groups.

Who is your audience? Try to find out something about the group you'll be showing to, in
regards to whether they're more interested in educational use of hypermedia for example, and in
particular, perhaps foreign language use, science or maybe even special ed. For a user group, there
may be more interest in just what's available in public domain stacks, how you can create stacks for
the family, games and the general creativity that HyperStudio makes possible.

Give them a little background: You probably won't have a lot of time to go into detail, but a
quick description of the idea behind hypermedia (combining text, graphics, sound to create an
exciting and interactive way of communicating ideas and information) will help give the audience a
frame of reference. Starting with a stack like HyperBrain and the Notebook, and explaining briefly
about the difference between backgrounds and objects, and the terms cards and stacks will help the
audience not only follow along as you show other stacks, but will help them understand conceptually
the underlaying structure of each stack, and what they all share in common.

Show them how to actually create something: We find the family tree stack works well for
presentations, because it's personal, and you can show how to add clip-art, text and sounds in just a
few minutes by creating a new card, for example a card for father Walsh's brother. Later versions of
the HS.Demo disk have a digitized picture you can use for a new card. By the way, although the
family tree stack currently uses a graphic object for the picture of father Walsh, we've found using
the Clip-Art functions gives people a better first look at the concept of importing clip-art from other
programs. The whole process of creating a new card, adding a graphic, button and sounds should
only take about 5-7 minutes, even with your having to explain it as you go.

When linking the two cards, adding a musical sound to the transition between cards is a good effect.
If you then use an invisible button over one of the digitized pictures to record yourself live saying
something like "Hi, I'm brother Joe!", you'll have shown most of the significant concepts of creating
the elements of a stack. The audience will then be able to better relate to each screen as you show
them further examples of existing stacks.

The key concept to get across here is how easy it is to use the tools in HyperStudio to create what you
want. HyperStudio is the only hypermedia system that doesn't assume the user has some
programming ability. It was intended to empower any Apple IIGS user with the ability to bring the
GS to life with projects that are relevent to them.

Share Useful, Real Information: It is always important to share with your audience

information they can use in their own work. For example, when explaining the family tree stack, be
sure to mention that the picture is brought in by digitizing with a video digitizer like ComputerEyes,
or a scanner like ThunderScan, and just how much something like that costs. Mention that other
programs like PaintWorks Gold or AppleWorks GS can be used as the source for text, graphics, etc.,



and where you got your copies of these programs if you have them. Share with them some of the
sources of helpful information or additional software or hardware that you found useful in your
project. Feel free to duplicate appropriate material from this Demo Kit, such as the Resource Guide,
that they can take back and use as a reference.

Sharing information about where stacks are available (America Online, CIS, GENIE), the latest in
newsletters, etc. is very useful to many people.

Involve your audience: Be sure to take any opportunities to find out just what the audience is
interested in as your presentation progresses. Even with anticipating their interests, certain questions
may come up that will help you select the parts of your own project, or sample stacks that you have
on hand, that will help them understand what hypermedia offers. You may even want to have
someone from the audience participate in recording a sound, or having themselves digitized with a
video camera, etc.

Let Us Help. We are more than happy to provide you with any flyers you may want to hand out,
or help you locate public domain stacks that may suit your presentation. If you are interested in
locating upcoming conferences or meeting people doing things similar to your own projects, please
call Della Smith, our hypermedia "evangelist", and we'll do everything we can to help you do the best
presentation possible!






HS Resource Guide

The following companies make products which are useful additions to the HyperStudio system:

Company

Digital Vision, Inc.
270 Bridge St.
Deham, MA 02026
(617) 329-5400

Thunderware, Inc.
21 Orinda Way
Orinda, CA 94553
(415) 254-6581

Vitesse, Inc.

13909 Amar Rd.
Suite 2A

La Puente, CA 91746
(818) 813-1270

B.E.A. Enterprises

100 E. Sierra, Ste 3115
Fresno, CA 93710
(209) 227-1721

Edmark Corp.

14350 NE 21st St.

P.O. Box 3903
Bellevue, WA 98009
(800) 426-0856

(800) 422-3118 (in WA)

Pioneer Communications
3545 Long Beach Blvd.
Suite 400

Long Beach, CA 90807
(213) 492-9935

AIMS Media

6901 Woodley Ave.
Van Nuys, CA 91406
(800) 367-2467

Optical Data Corp.
30 Technology Drive
Box 4919

Warren, NJ 07060
(800) 524-2481
(201) 668-0022

Product/Cost Description

ComputerEyes™ Digitize images from your video camera, VCR,

Video digitizer or laserdisc player.

$249.95

ThunderScan™ Digitize images using an ImageWriter printer as

Scanner a scanner. Good for digitizing printed images

$219.95 like photographs, maps, etc.

Quickie Great for scanning clip-art, photos from

Hand Scanner books, etc. Similar to ThunderScan, but

$299 is hand-held, rather than mounted in the
printer.

Clip-Art Black & White clip-art, 1000's of images in
each package.

"Things You See Everyday"

"Life Sciences - Vol.1"

"Graphic Images, Vol.1"

$39-$59

TouchWindow™ Touch-sensitive monitor screen. HyperStudio

$250 can use this as an alternative to the mouse for

user input. Very good for young children, or
anyone new to the computer. Even if you're
used to the mouse, the TouchWindow is a very
nice way of using HyperStudio stacks.

Laserdisc player HyperStudio-compatible laserdisc players.
Models 2200, 4200, 8000.
$895, $1095, $2285

Laserdisc titles 100's of laserdisc educational titles.

Laserdisc titles Publisher of many laserdisc titles.
"Windows on Earth Science"

"Windows on Physical Science"

"Windows on Life Science"

(and many others!)

"Voyager Gallery"

"Shuttle Downlink"



VideoDiscovery, Inc. "BioScience I/II" Publishers of many laserdisc titles.
1515 Dexter Ave. N. "Life Cycles"

Suite 400 "Cell Biology"
Seattle, WA 98109 "Death Trap"
(206) 285-5400 "Pollination Biology"
"Encyclopedia of Landscape Plants"
"Physics of Sports"”
ABC Interactive "The '88 Vote" Interactive video disc of the 1988
distributed by Optical Data Presidential campaign.

(see page 1)

Voyager Co. Publishers of many laserdisc titles.
1351 Pacific Coast Hwy. "Regard for the Planet”
Santa Monica, CA 90401 "National Gallery of Art"

(213) 451-1383 "Computer Dreams"
ZTek Co. Videodiscs, misc. Directory of many 100's of laserdisc
P.O. Box 1055 and CDROM titles.

Louisville, KY 40201-1055
(800) 247-1603

MECC, Etc. Videodisc, misc. Catalog of varied products, including
2490 Lexington Ave. North laserdiscs, players, computer hardware,
St. Paul, MN 55126 printer cards, software, etc.

(800) 228-3504 ext 527
(800) 481-3500 ext 527 in MN

The Laser Beam Videodiscs, misc. Catalog of laserdisc titles. Mostly
Starship Audio Industries popular movies, but also equipment, and
605 Utterback Store Rd. some educational titles.

Great Falls, VA 22066
(703) 430-8692

Emerging Technology Consultants Directory of over 700 laserdisc titles.
P.O. Box 12444 "Videodisc Compendium"
St. Paul, MN 55112 $15

(612) 639-3973

Magno Sound & Video Laser disc mastering '
729 7th Ave. This company will convert a standard

New York, NY 10019 $300 for a single disk. VHS video tape into a laser disc with
(212) 302-2505 less $3 in qty. a very quick turn-around time.

Indexing extra. Additional video services also available.
Editdroid Laser disc mastering
3000 W. Olympic Blvd., Suite 1550 This company will convert a standard
Santa Monica, CA 90404 VHS video tape into a laser disc with
(213) 315-4880 a very quick turn-around time.
(213) 315-4881 (fax) $200-$300 (10 days vs. 48 hrs).
HyperLeamning Network  "HyperLearning Forum" Organization promoting the uses of
Box 103 $29/yr (4 issues) hypermedia in education. Quarterly
Blawenburg, NJ 08540 (18 mos/6 issues offer newsletter. Free sample of newsletter
(609) 466-3196 through 6/1/90) available on request.
A2 Central "Stack Central" Bi-monthly 2-disk magazine-on-a-disk.
P.O. Box 11250 $42/yr Includes articles, tips, sample stacks,
Overland Park, KS 66207 (6 2-disk issues) clip-art, sound effect, etc. Free sample

(913) 469-6502 disk available on request.



Apple Computer Corp.
10525 Mariani Ave.
Cupertino, CA 95014
(408) 996-1010

Teaching Technologies

P.O. Box 3808

San Luis Obispo, CA
93403

(805) 541-3100

Radio Shack Stores

Apple II Video Overlay Card

$550

Laser disc players

Laserdisc/GS cable

$25

"Multimedia Guide"

RF Modulator
$30
#15-1273A

Stereo Mixer

$60
#32-1100A

Speakers
$79.95
#40-1262

Video Processor
$129.95
#15-1276

Video Enhancer
$24.95
#15-1955

Audio Cables
$5.69
#420-2309

Phono Coupler
2 for $1.39
#274-1553

Mixes video image from VCR, laserdisc,
video camera or other video source with
the computer display, and shows the
combined image on the GS monitor.

Non-profit organization promoting interactive
video and offering a variety of hardware
items, training workshops, consulting, and
and other services.

Helpful information on interactive video.

Converts monitor video output from GS
RCA jack to signal that can be displayed
on Channel 3or4of aTV.

Mixes sound output from Apple IIGS with
sound from laserdisc player, lapel mike,
tape players and other sources for final
output to another tape player, the GS
digitizer, or a PA system in a presentation.

Amplified Speakers that can be used with the

'GS for presentations. AC powered, 6 watts.

(a better set is available from A2 Central, but
these may fill a need in an emergency)

A rather sophisticated audio/video enhancer

that would be of most use when creating

video tapes where that last 10% quality
improvement is important. Many special features
and effects possible with this unit.

A low-cost signal strength control for

both audio and video signals. May help for
rare situations where computer and VCR or
a classroom TV don't match well.

IMPORTANT: Neither of the above
two devices are required for VCR

use with the GS, but may be of interest
to more advanced users.

Set of four 3-ft cables, color coded. May be
use to connect GS to laserdisc player, or
nearby VCR, monitor, etc. Longer cables
may be purchased for greater distances as
long as they have the same phone connectors
at each end (part # 42-2368 is 12' cable).

Simple connector to link one or more shorter
audio/video cables together.



Radio Shack Stores

Epson America

2780 Lomita Blvd.
Torrance, CA 90505
(800) 922-8911

Quality Computers
15102 Charlevoix
Grosse Pointe Park, M1
(800) 443-6697

(313) 331-0700

Chinook Technologies
601 Main St., #635
Longmont, CO 80501
(303) 678-5544

(800) 999-7034

Applied Engineering
P.O. Box 5100
Carroliton, TX 75011
(214) 241-6060

ON THREE, Inc.
1802 Mitchell Rd.

Lake Stevens, WA 98258

(206) 334-8001

Phono/Mini plug This adapter is needed to plug a phono style
$1.99 audio cable into the headphone jack on the back
#274-378 of the GS. The other end of the final cable
would then be plugged into the "audio in" of
the VCR, camcorder or classroom monitor. If
this is out of stock, you can also use #274-369,
which has two phono plug outputs, although the
GS headphone jack is not stereo (just use either

output plug).
Crystal Image Projector
$3449 Excellent GS-compatible RGB/NTSC

video projection system. Small unit is very
portable (13 lbs, 16" x 4.3" x 9.6").

RAM upgrades Supplier of GS RAM chips to upgrade 512K
reg. $39/256K machines, memory cards, etc.
$32/256K for HS users!

External Hard Disk A good supplier of external hard

$669/20Mb disks! These prices include the Apple SCSI
$829/40Mb card, which would otherwise run about $100.
$1199/80Mb

Hard disks, Long-time supplier of Apple hardware.
memory cards

(call for prices & product list).

RAM Cards, misc. = RAM expansion cards, memory testing
(3120 for 1Mb) software, misc. software, etc.



On-line sources of stacks and clip-art.

Note that access to these requires a modem, and appropriate communication software. The modem
should be 1200, or even better 2400 baud (a 2400 baud modem goes for about $130).
Communicatons software should be something well-supported like Point-to-Point (Beagle Bros.,
Inc.) or AppleWorks GS (Claris).

Quantum Computer Services

8619 Westwood Center Dr. America Online On-line computer service with HyperStudio
Vienna, VA 22182 $6/mo. min. library of stacks & clip-art, technical support,
(800) 227-6364 $5/hr after 6pm - message exchange with other HyperStudio

$10/hr before 6pm and Apple OGS users. Many other topics
and services are available.

RWP Electronic mail address: RWagnerinc
To find the HyperStudio area:

After signing on, press Apple-K for "keyword". Enter "aed" (for Apple Education). This will take
you to a menu for the education forum area. In the menu that appears, select "Direct Connect”. You
will see the entries "Roger Wagner Publishing, Inc.” and "StudioWare". Choose Roger Wagner
Publishing, Inc. to read the messages among HyperStudio users, dps on using the software, news of
contests, and technical support and update issues. Choose StudioWare to see the library of public
do?'@ and shareware HyperStudio stacks and clip-art files (95% public domain on stacks, 100% pd
on clip-art).

On America Online, RWP and the StudioWare libraries are "cross-linked" to several other forums,
and the same files can be accessed from the Graphics (keyword: "agr™), Producdvity ("apr"), and
Music and Sound Forums ("ams").

Note: America Online provides their own communications software, which is included in the
subscripton price, so no additional software is required.

CompuServe, Inc. "MAUG/CIS" "Mac/Apple Users Group”
5000 Arlington Centre Blvd.  On-line service. See descripdon of
P.O. Box 20212 $12.50/hr. "America Online".

Columbus, OH 43220

(614) 457-8630

(800) 848-8990

RWP Electronic mail address: 71660,50
To find the HyperStudio area:

After signing on, enter the command "Go Appfun". This will take you to a message board of
technical support quesdons, and dialog between HyperStudio users.

Typing "LIB 11" will select the HyperStudio stack and clip-art library, and then typing BROWSE
will show a descriptdon of each file, and give you the opdon of downioading it. Typing HELP will
get you more details on how to use the library.

Separate communications software will be needed for CompuServe.



GE Information Services GENIE On-line service. See description of
401 N. Washington St. $29.95 sign-up "America Online".

Rockville, MD 20850 ($10 rebate)

(800) 638-9636 $6/hr after 6pm; $18/hr before 6pm

RWP Electronic mail address on GENIE: Roger.Wagner
To find the HyperStudio area:

After signing on, enter the command A2. This will take you to the Apple II area. Select item #1 for
Bulletin Boards, and enter SET 32 to set the topic to Roger Wagner Publishing, Inc. Topic 2 is
HyperStudio, where you'll find messages between HyperStudio users and technical support answers
and tips. Other topics provide information and dialog on other RWP products. Type READ 2 NEW
to read recent messages about HyperStudio.

To get to the stack and clip-art libraries, select item #3 at the main A2 menu ("Libraries”). At the next
menu, choose item #8 to set the library, and choose item #29 to select the HyperStudio library.

From there, you can use item #2 for a directory of available library files, and #6 to download specific
files.

Separate communications software will be needed for GENIE.
All on-line services have "Sysops" (System Operators) that will answer questions directed to them

about how to use the service. In addition, all services offer an 800-line customer service department
that will answer questions as well.

Della Smith Hypermedia Evangelist

Della Smith is our personal contact with
Roger Wagner Publishing, Inc. those seeking to promote and explore
1050 Pioneer Way, #P hypermedia on the Apple IIGS.
El Cajon, CA 92020
(619) 442-0522

(800) 421-6526

Contact her for information about conferences, workshops, trade shows, etc. that may be happening
in your area that you would like to either attend or at which you'd like to do a presentation. We can
supply flyers, handouts, sample stacks for use in your presentation or workshop, and suggestions on
organizing a presentation.

If you are organizing a conference or workshop in your area, let us know and we'll try to locate
teachers in your area using HyperStudio who can share their experiences and ideas with others.

We are also organizing a list of as many people as possible regarding their current projects with
HyperStudio. So, if you're creating a stack on ESL, special ed, chemistry, interactive video,
industrial education, or whatever, let us know, and we'll make your name available to others who
may be interested in similar projects. Likewise, if you have a unique HyperStudio project you're
working on, call us to see if we have any leads on how to contact others with similar interests.
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